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Preface

Manual Structure

This manual documents the MTS Series Dolby Digital Audio Analyzer
application. If you purchased an MTS 200 Series test system and are looking for
information about installation, first-time operation, or specifications, refer to the
MTS 200 Series Hardware Installation and Specifications Compaq Proliant 1600
Platform Technical Referenc@ektronix part number 071-0261-XX.

For the latest information about MTS200 Series Software features and bugs,
refer to theMPEG Test System Software Version 3.0 Read Thisdeicsiment,
Tektronix part number 071-0537-XX, that accompanied your test system,
software product, or upgrade.

For information about the Windows NT Workstation operating system, refer to
the Microsoft documentation that accompanied your computer.

Wherever possible, this manual uses symbols and terminology consistent with
Microsoft Windows and MPEG-2 standards. Refer to your Windows documenta-
tion for definitions and explanations of Windows terminology.

This manual is divided into the following sections:

Getting Started. The Getting Started section contains the information you need to
get the Dolby Digital Audio Analyzer up and running.

Operating Basics. The Operating Basics section contains a functional overview of
the product and basic user interface operating instructions.

Reference. The Reference section contains in-depth descriptions of the analyzer
capabilities, the software interface, and configuration options.

Index.
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Software Version

Table i lists the MTS 200 Series MPEG Test System application version number
supported by this manual. To verify an application version number, btdgrt
in the application menu bar; then seldbbut from the Help menu.

Table i: MTS 200 Series MPEG Test System (V3.0) supported applications

Version Manual
Application supported | Document title part number
Dolby Digital Analyzer 1.0 and MPEG Test System Dolby Digital Audio Stream Analyzer User Manual | 071-0535-00
above

Contacting Tektronix

Product For application-oriented questions about a Tektronix measure-
Support ment product, call toll free in North America:
1-800-TEK-WIDE (1-800-835-9433 ext. 2400)
6:00 a.m. — 5:00 p.m. Pacific time

Or contact us by e-mail:
tm_app_supp@tek.com

For product support outside of North America, contact your
local Tektronix distributor or sales office. You can also call
1-503-627-2400 between 14:00 and 01:00 UTC (GMT).

Service Contact your local Tektronix distributor or sales office. Or visit
Support our web site for a listing of worldwide service locations.

www.tektronix.com

For other In North America:
information 1-800-TEK-WIDE (1-800-835-9433)
An operator will direct your call.

To write us  Tektronix, Inc.
P.O. Box 1000
Wilsonville, OR 97070-1000

iv MPEG Test System Dolby Digital Audio Analyzer
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Getting Started

The Dolby Digital Audio Analyzer enables you to analyze elementary audio
stream files encoded to the AC-3 standard. You can use this tool to analyze
stream samples or whole records stored in files. Developers of AC-3 encoders or
decoders can use this tool in their test and development phase.

Product Description

You can perform the following tasks with the Dolby Digital Audio Analyzer:

Display the structure of AC-3 streams in order to relate the streams to the
AC-3 standard.

Detect nonstandard streams and evaluate the cause of an audio problem.
Analyze streams at different levels.

Perform the following analyses: Syntactic (structural), Semantic (coherence
between all components), and CRC (error checking).

Extract audio elementary streams from transport stream files.
Save all or part of an AC-3 audio stream as an *.AC3 file.

Generate graphic views that provide high-level information about the
characteristics and structure of the stream.

Generate interpreted views that display field values within the stream.

Audio Stream File Types  The Dolby Digital Audio Analyzer can display the following audio elementary
streams formats:

AC3 files — Audio stream files encoded in accordance with the Advanced
Television Systems Committee (ATSC) Digital Audio Compression (AC-3)
Standard (December 20, 1995).

.PRG files — MPEG-2 program stream files used in the DVD standard. You
must enter the SID (stream identifier) of the AC-3 stream.

.VOB Files — DVD video object. Streams of this type can contain up to 8
AC-3 files. You must provide a stream ID (default 189) and a substream ID
starting at 128.

.TRP files — Raw MPEG-2 transport stream files used in the U.S. ATSC
Digital Television broadcasting system. You must enter the PID of the AC-3
stream.

MPEG Test System Dolby Digital Audio Analyzer 1-1



Getting Started

Installing Software

On MTS 200 Series Test
Systems

On Personal Computers

Entering the General
(License) Password

Starting the Analyzer

Dalby Digital
Analyzer

1-2

The Dolby Digital Audio Analyzer is part of the MTS 200 Series Test System
suite of hardware and software components used to create, generate, acquire, and
analyze MPEG, DVB, and ATSC transport and program streams.

If you purchased an MTS 200 Series test system and need system-related
information or specifications, refer to tMI'S 200 Series Hardware Installation
and Specifications Compagq Proliant 1600 Platform Technical Refgrence
Tektronix part number 071-0261-XX.

If you purchased the Dolby Digital Audio Analyzer as an upgrade to an MTS 200
Series test system and need software installation instructions, refer to the
MTS2F06, MTS2F07, MTS2F08, MTSFAC3, and MTSFOMX MPEG Test System
Upgrades Instructionsmanual, Tektronix part number 075-0292-01.

If you purchased the Dolby Digital Audio Analyzer to install on a personal
computer and need software installation instructions, refer eI T182ES,
MTS2AN, MTS2CR, MTS2TS, and MTS2AC3 MPEG Application Software
Version 3.0 Installation ManualTektronix part number 071-0370-01.

Before you can operate the Dolby Digital Audio Analyzer you must enter the
correct password for your software configuration. Use the procedure in your
installation manual to enter the general password.

To start the Dolby Digital Audio Analyzer, log on to your MTS 200 Series test
system or personal computer and start Windows NT.

Locate theTektronix MPEG Test Systaoon on the Windows NT desktop. If it
is not already open, double-click the folder icon to open the program group
window.

Double-click theDolby Digital Analyzer icon in the program group window.

MPEG Test System Dolby Digital Audio Analyzer
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Exiting the Analyzer

To quit the Dolby Digital Audio Analyzer, seleekit from the File menu or
click the close box in the upper-right corner of the application window.

Close
zer - [Statistic view] =] E3{ bOX

YWiew Analysis  DataStorage  Window  Help 18] x|

Il ==l an (wval

The current analyzer configuration is preserved and used the next time you start
the application.

To close an active view window without exiting the analyzer application, select
the close button on the active view window or sel#ose viewfrom the
analyzer Window menu.

To close all windows without exiting the analyzer application, s€lkxgte all
from the analyzer Window menu.

Opening an Audio Stream File

To open an audio stream file, do the following:

1. SelectOpen from the File menu. The Open dialog box displays.

Open HE
File name: Ealders:
|acm0d3_2.ac3 chymts2004audio

Cancel
acrnod?_l.ac3 =] [= e, =] 4'
acmaod3_.ac3 = WTS200

acmod3_2.acl = AUDIO

- I
Listfiles of type: Drives:

Dolby AC-3 Stream (AC3) 7| |Ec =l Network. |

The default selection from the List files of type drop down selection box is
Dolby AC-3 Stream (.AC3). To display a file that uses another suffix (see
Audio Stream File Typem page 1-1), select the appropriate suffix from
the List files of type selection box.

MPEG Test System Dolby Digital Audio Analyzer 1-3
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2. Select the AC-3 audio file you want to open.

3. Click OK. The Frame view and the Main Characteristics view for the audio
stream open.
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Operating Basics

In this section you will find basic operating information, explanations of the
views used to display audio streams, and menu descriptions. For basic informa-
tion on the Windows operating system, such as minimizing windows or using the
scroll bars, refer to your Windows documentation.

Functional Overview

The Dolby Digital Audio Stream Analyzer uses two window types to display
audio streams: the Application window and the View window.

Application Window  The Application window provides the main operating environment for the
analyzer. The following figure shows the basic features of the Application
window.

TileBar —— FE D e L T e
Menu Bar > File Edit “iew Anapsis Decode Options ‘Window Help

Upper Toolbar ——» £ 2 w il

Edit Toolbar ——» W4 20 I |4
|

Status Bar
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Title Bar. In the Application window, the Title Bar displays the application name
on the left and provides standard Windows window controls on the right.

Menu Bar. The Menu Bar provides access to commands that control analyzer
display, analysis, and appearandsing Menusbeginning on page 2-11,
describes the menu selections.

Upper Toolbar. The Upper Toolbar provides shortcut buttons to some commonly

used menu selections. Move the mouse over an Upper Toolbar button to display

the button name.

Button | Name Description
r_El| Open Displays the Open dialog box.
El Save as Displays the Save as dialog box.
:l Frame view Displays the Frame view window for the active audio stream.
!l Add view Displays a submenu. You must specify a view to display.

Main character-
istics view

Displays the Main Characteristics window for the active audio
stream.

Edit Toolbar. The Edit Toolbar buttons allow you to move through the items of
the current view and to view the errors in an audio stream file. The toolbar
buttons are equivalent to Edit menu selections.

Button [ Name Description
ﬁl First Displays the first item in the active view.
i| Previous Displays the previous item in the active view.
_?| Goto Displays a dialog box to enter details about the active view you
want to display.
_;| Next Displays the next item in the active view.
ﬂ' Last Displays the last item in the active view.
Number of Counts the number of items in the element and displays the
Items number at the top of the Interpreted view.
p2| |Nexterror Displays the next item in the audio stream file containing an error.

This button is active when the question mark is red.

Status Bar. The Status Bar, which is located at the bottom of the analyzer
window, describes a menu selection as you highlight the selection.

MPEG Test System Dolby Digital Audio Analyzer
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View Window  The View window displays the structure of an audio stream file within the

Application window. The following figure shows the basic features of the View
window.

£ Dolby Digital [AC-3) Audio Analyzer

File Edit Wiew Analysis Decode Options Window Help

Title Bar

Top Line Frarce 1 - Pasition : 0b - T - 0.000000 s

B ] e
Audio

chronizatic Binary Awdliary  Error Check
Inforrnat Strearn Blocks data

Informatio

. Time duration : : 32.000
Window s i

Frame Size : : 1792 bytes

The CRC for the current frare 15 wahid

W4 2 v

Title Bar. In addition to standard window controls, the View window Title Bar
provides the following information about the display:

®  View type.

®  Name of the displayed audio stream file (or the transport stream from which
the audio stream was extracted). If you maximize the View window, this
information displays in the Title Bar of the Application window.
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Top Line. The Top Line provides the following information for AC-3 files. (This
information is not available for raw AC-3 files):

®  View type.

®  Frame number of the displayed element, relative to the first synchronized
frame. The number of the first synchronized frame is one.

m  Position of the displayed element, indicated in bytes (b) and relative to the
first byte of the first synchronized frame. The position of the first synchro-
nized frame is zero.

m  Time stamp of the displayed element, indicated in seconds (s) and relative to
the first byte of the first synchronized frame. The time of the first synchro-
nized frame is zero.

Analyzer Views

This section explains the displays the analyzer uses to view data. For more
complete information about these views, seeRbferencesection beginning on
page 3-1.

Main Characteristics ~ The Main Characteristics view window displays when you open an audio stream
file. You can also access this view by selectingMiaén characteristics button
from the Upper Toolbar or by selectiMain characteristics from the View
menu. You can open a Main Characteristics view from any Frame view window.
You cannot access this view from a Binary or Hexadecimal view.

[ Frame view > acmodswp.ac3:2
Main Characteristics  Frame 1000 U Graphica| Channel
Indicator
AC-3 Version 2
Sampling Frequency 42 kH=
Type of Sarvice Complete Main
Andio Coding Mode 21
Eitrate 447 kbiths
Center Channsl nomne
LFE Channel none
Humber of Channels 3
Copymght yes
Orznal Copy yes

The Main Characteristics view displays the main properties of the opened
stream. This view has a Graphical Channel Indicator in the upper-right corner of
the window.
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The Main Characteristics view provides quick access to the following informa-
tion about the audio stream:

AC-3 Version numbet.ists the version of the displayed signal.

Sampling Frequencyisplays the sampling frequency of the displayed
signal.

Type of ServiceDisplays the type of service of the displayed signal.

Audio Coding ModeThe first displayed number represents the number of
left, front, and right channels. The second number represents the number of
surround channels.

Bitrate. Displays the bitrate of the displayed signal.

Center ChannelThe analyzer displaysesor noneto indicate whether a
center channel is present in the analyzed stream.

LFE ChannelLow frequency enhancement channel). The analyzer displays
yesor honeto indicate whether a Low Frequency Effect is present in the
analyzed stream.

Number of Channeld he total number of channels that are present in the
analyzed stream, including front channels, surround channels, and center
channel.

Copyright The analyzer displaysesor none

Original Copy The analyzer displaygesor none

Graphical Channel Indicator. The area in the upper-right corner of the Main
Characteristics window contains the Graphical Channel Indicator. In this area,
black blocks represent the audio channel configuration as explained in the
following table.

Block location Channels present in the stream
Upper left corner Left channel

Upper right corner Right channel

Middle of top line Center channel

Middle of bottom line Surround channel

Lower left corner Left surround channel

Lower right corner Right surround channel

Center of the square LFE channel

MPEG Test System Dolby Digital Audio Analyzer 2-5
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Frame View

In the example below, the Graphical Channel Indicator displays a frame with
three audio channels: a left channel, a right channel, and a surround channel.

[ Frame view -» acmodswp_ac3:2

Main Chavarteristics  Frame 1000 I 4—} Graphical Channel
Indicator

When you open an audio stream file, the Frame view automatically opens. You
can add additional views of the same frame by selegtitigview from the

Window menu or by selectinydd view in the Upper Toolbar and selecting
Frame view from the View Type submenu.

Adding views does not allow you to compare one frame with another. In order to
do so, you must display separate View windows directly from the parent view
window. (From the View menu seldétame view). You can also display frames

in Binary or Hexadecimal as explained on page 2-9.

B8 Frame view -> ecl ac3 [ (0] ]

e {7 e
Audio

mchronizatic Bit Strearn
Informat

=

Frarne 1 - Position : 0'b - Tine : 0000000 s

Aopdliary  Emor Check
Information Blocks data

Tirae duration : - 32.000 ms

Frame Size : : 1702 botes

The CRC for the ourrent frare is wralid

The Frame view is a graphic representation of the elements associated with the
audio stream, one frame at a time. Each element is represented by an icon.
Double-click any of the icons to open a more detailed view (interpreted view)

with additional information. Interpreted views provide a graphical way to look at
AC-3 audio stream elements. You can navigate through each frame in the various
element files with the Edit Toolbar.
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S, BSI, AUX, and CRC Views. To open an interpreted view of the elements listed
below, double-click the icon in the Frame view. See the following pages in the
Referencesection for additional information:

m S| (Synchronization Information) See page 3-5
m  BSI (Bitstream Information) See page 3-5
m  AUX (Auxiliary Data) See page 3-15
m  CRC (Cyclic Redundancy Check) See page 3-16

Audio Block Views. When you double-click an Audio Block icon, the analyzer
displays several elements horizontally, representing the block’s primary syntactic
structure. These component elements are also positioned vertically, according to
information type:

® Common information

m  Coupling channel

m  Full Bandwidth channels (FBW)

®  Low Frequency Enhancement channel (LFE)

With the Frame view active, you can select any audio block view (ABO-AB5)
either by double-clicking the desired icon in the Frame view, or by selecting it
through the View menu. You can also add an Audio Block view using the Add
view command from the Window menu or Upper Toolbar.

In every view dealing with the audio blocks of a frame, the displacement unit is
the block. All views display the current block number (from 0 to 5).

Each block icon represents real data read in the stream and their block represen-
tation represents the order of appearance in the frame. Read the structures from
left to right and from top to bottom.

The current frame determines the presence of icons representing the Dynamic
Range Control, the Rematrixing Flags, and the Delta Bit Allocation. The
following illustration shows the maximum expansion of the view.

MPEG Test System Dolby Digital Audio Analyzer 2-7
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[ Audio Block view > ecl.ac3 = 3
-
Audin Block view (&B) Block 0 - Iern 1- Frame 1 - Position : 0'b - Tire : 0.000000 5

Block Dither flags  Drymarnic range  Coupling Exponent  Exponents  Bit allocation Dummy data  Quantized
switching Strategy Info Strategy Ivantissa

Cornroon

Coupling

FEW

LFE

WAl 2 S ¥

When the current view is an optional syntactic view such as Delta Bit Allocation,
the Next button may not find any other information of this type in the following
blocks, so the Next command may fail. In this case, terminate the search by
pressing th&SC key.

Audio Block Interpreted Views. When you double-click an Audio Block icon, the
analyzer displays an interpreted view of the MPEG elements listed below. The
display formatting changes depending on the type of data.

See the following pages in tiReferencesection for additional information:

m  Block Switching See page 3—-7

m  Dither Flags See page 3-7

®  Dynamic Range Control See page 3-7
®  Coupling Strategy Information See page 3-8
m  Coupling Data See page 3-8

®  Rematrixing See page 3-9

m  Exponent Strategy See page 3-10
m  Exponents See page 3-10
m  Bit Allocation See page 3-12
m  Delta Bit Allocation See page 3-13
®  Dummy Data See page 3-14
®  Quantized Mantissas See page 3-15
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CRC Status Message. Each time you open a frame, the analyzer performs a CRC
analysis and displays the result at the bottom of the Frame view. This status
message indicates one of the following conditions:

m  The entire current frame is valid.
m  The first 5/8 frame is valid; the remaining data may be corrupt.
®  The last 3/8 frame is valid.

®  The entire frame is invalid.

EFlame view -» ecl.ac3 (=10 =]

Frare 1 - Position : 0% - Time : 0.000000 ras

Binary Audio

mehronizatic Apdliary Error Cheek
Informmat Stream Blocks data
Informatio

Tirne duration : - 32000 rs

Frare Size : : 1792 bortes

CRC Status [ The CRE for the ourrent frare is valid
Message

4 L3

Binary and Hexadecimal ~ The Binary and Hexadecimal views display the audio bitstream for the AC-3
View  syntax indicated in the Top Line of the Frame view window.

To display a Binary or Hexadecimal view, do the following:

1. Click theAdd view button in the Upper Toolbar or seléad view from the
Window menu.

2. Select the type of view you want to add: Binary or Hexadecimal. If a view is
dimmed in the menu, that view is unavailable.

Graphical Views  The analyzer can plot three types of graphs: Dialog Normalization, Heavy
Compression, and Dynamic Range. The analyzer plots the item number on the
horizontal axis and the value on the vertical axis. For additional information
about these graphs, seaphical Viewsheginning on page 3-16.

Adding Views  To add multiple view windows to the Application window, sekdt View
using the Upper Toolbar or the Window menu, and then select the view type you
want to display. When you display a new view with this method, the Edit
Toolbar functions navigate through all added views, active or inactive.

MPEG Test System Dolby Digital Audio Analyzer 2-9
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When the active view is an interpreted view, you can add a Binary or Hexadeci-
mal view of the information displayed in the interpreted view.

To add a view using the Add View command, do the following:

1. For this example, open the Synchronization Information (Sl) view. Make
sure it is active (highlighted).

2. Click theAdd view button in the Upper Toolbar or seléad view from the
Window menu.

3. Select the view you want to add from the resulting menu. For this example,
select theHexadecimal

4. Use the Edit Toolbar to navigate to Frame 5. Both views change to show the
synchronization information for Frame 5.

You may find it useful to compare interpreted views of the various audio block
components. To compare blocks, items, and frames, do the following:

1. From the Audio Block view, double-click the icon for the audio block
component you want to analyze. This displays the interpreted view for that
component.

2. Select the Audio Block View again (make it active) and double-click the
same icon as in step 1.

3. When the second audio block interpreted view window appears, dismiss the
Audio Block View window.

4. Use the Edit Toolbar buttons to navigate to the desired blocks, items, and
frames. Only the active window changes, allowing you to compare the fields
and values of the various items between windows.

The following table shows the available views:

From this view window You can display

Frame view m  Additional Frame view
®  Binary or Hexadecimal view
m  Additional Main Characteristics view

Interpreted view m  Additional interpreted view
®  Binary or Hexadecimal view

Binary or Hexadecimal view m Interpreted view of the syntax
®  Binary or Hexadecimal view

Main Characteristics m  Additional Frame view
®  Binary or Hexadecimal view
m  Additional Main Characteristics view

2-10 MPEG Test System Dolby Digital Audio Analyzer
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Using Menus

The analyzer menus allow you to execute commands and access the main
syntactic views. You can use the keyboard or mouse to access the analyzer
menus. You can also use the Upper Toolbar buttons as shortcuts to some menu
selections.

Using the Keyboard. To open a menu, press and hold A& key while you

press the underlined letter in the menu name. For example, to open the File
menu, press and hold théT key while you presB. To select a command after
you open a menu, press the underlined letter in the command name, or use the
arrow keys to highlight the command and then pe#$$ER. To close a menu,
press th&aSC key.

Using the Mouse. To open a menu, click the menu name in the Menu Bar. To
select a command from an open menu, click the command name. To close a
menu, click outside the menu.

Using the Upper Toolbar. Click an icon in the Upper Toolbar to open the
associated submenu or to execute the associated command.

Table 2—1 describes each of the menu selections.

Table 2-1: Menu selections

Menu Selection Description

File Open Displays the Open dialog box to identify the existing
audio stream file you want to view. Identical to the
Open button on the Upper Toolbar.

Close Closes the active audio stream.

Save as Displays the Audio Stream Saving dialog box to
specify how much of the stream you want to save.
After you select OK, a standard Save As dialog box
displays. Same as the Save as button on the Upper

Toolbar.

Print Displays a standard Print dialog box to print the
active view window.

Printer setup Displays the Page Setup dialog box from which you

specify the paper size, orientation, and page
margins. The dialog box also provides access to
printer options.

Exit Ends the session and closes the Dolby Digital Audio
Analyzer application.

Edit Next Item Displays the next item in the audio stream.

MPEG Test System Dolby Digital Audio Analyzer 2-11
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Table 2-1: Menu selections (cont.)

Menu Selection Description

Previous Item Displays the previous item in the audio stream.

First Item Displays the first item in the audio stream.

Last Item Displays the last item in the audio stream.

Goto Displays the specified item in the audio stream.

Number of ltems Calculates the number of items in the active view
and displays the number in the upper portion of the
active view window.

Next error Displays the next item in the audio stream that
contains an error.

View Main Characteristics Opens a Main Characteristics Frame view... window
of the audio stream indicated in the Title Bar.

Frame view Opens a Frame view of the audio stream indicated
in the Title Bar.

Sl View Opens a Synchronization Information view. Same as
double-clicking on the Sl icon in the Frame view.

BSI View Opens the Bit Stream Information view. Same as
double-clicking on the BSl icon in the Frame view.

Audio Block View Displays a submenu of Audio Blocks 0 through 5.
Selecting any block opens the corresponding Audio
Block view. Same as double-clicking any of the
Audio Block icons (AB0-AB5) in the Frame view.

Auxiliary Data View Opens the Auxiliary Data View. Same as double-
clicking on the AUX icon in the Frame view.

CRC View Opens the CRC (error checking) view. Same as
double-clicking on the CRC icon in the Frame view.

Analysis Syntactic Performs a Syntactic analysis on the audio stream
indicated in the Title Bar of the secondary window.

Semantic Performs a Semantic analysis on the audio stream
indicated in the Title Bar of the primary window.

Automatic Performs the analyses you selected in the Options
menu for Automatic Analysis.

Decoding | Stream Summary Generates a textual stream summary.

Graph Displays a submenu allowing you to select from
three graphical displays: the Dialog Normalization
graph, the Heavy Compression graph, and the
Dynamic Range graph.

Options Base Displays the Base dialog box to set the numeric

base (decimal or hexadecimal) of the values
displayed in the interpreted views.
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Table 2-1: Menu selections (cont.)

Menu Selection

Description

Font

Displays the Font dialog box to set the type,
typeface, and size of the font used for most of the
views windows. The Binary and Hexadecimal view
windows are not affected by the font selection.

Interpretation

Displays the Interpreted view option dialog box to
display either the length or position of the field in the
bitstream. This information is displayed in
interpreted views and available only in Linear
format.

Output Message in File

Automatically saves analyses results error
messages to a file. You can specify the path using
the Directories command.

Directories

Sets the default path for saving messages to file
and for saving and loading configuration files
(Configuration Directory).

Automatic Analysis

Opens a dialog box to select the analyses
performed (Syntactic, Semantic, or both) when you
select Automatic from the Analysis menu.

Read Configuration

Displays the Read Configuration dialog box to
specify which previously saved configuration file
(*.acf) to load into the current analyzer session.

Save Configuration

Displays the Save Configuration dialog box to save
the current analyzer configuration to file (*.acf). You
can transfer the file to another system or reload it at
a later time.

Set Default Configuration

Loads the default configuration file.

Window Cascade

Displays the open view windows on top of one
another, enlarging the Main Characteristics window
if necessary.

Tile

Fits the open view windows to the application
window.

Arrange Icons

Arranges all minimized windows from left to right
across the bottom of the application window.

Close view

Closes the active audio stream file.

MPEG Test System Dolby Digital Audio Analyzer
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Table 2-1: Menu selections (cont.)

Menu Selection Description
Close all Closes all view windows.
Add view Opens a submenu to create an additional view of

the current data. The submenu changes depending
on your selection. Same as the Add View button on
the Upper Toolbar.

Help Contents Opens the Help Topics: Dolby Digital Audio Stream
Analyzer Help window. Select an analyzer help topic
or click on a tab to the view the index or specify a
search topic.

Using help Opens the Help Topics: Windows Help window.
Select a Windows help topic or click on a tab to the
view the index or specify a search topic.

About Audace Displays the analyzer version number and copyright
information.

Audio Stream Analysis

This section explains how to open, decode, analyze, save, and print audio stream
files.

Extracting an Audio  To extract and analyze an audio elementary stream encoded in a transport stream
Elementary Stream froma file, use the following procedure:

Transport Stream 1. ldentify the audio stream PID for the packets of interest. If necessary,

examine the transport stream first with the MTS 200 Series MPEG-2
DVB/ATSC System Analyzer (Deferred-Time Analyzer application).

2. SelectOpen from the File menu.
3. Select the appropriate file from the Open dialog box.

4. Enter the PID of the packets that contain the audio stream.

NOTE. If you have the Tektronix MTS 200 Series MPEG-2 DVB/ATSC System
Analyzer, you can open the Dolby Digital Audio Analyzer to analyze Dolby
elementary streams. From the Deferred-Time Analyzer Hierarchic View,
right-click the Dolby audio icon and sele&€-3 Stream Analyzefrom the

pop-up menu.
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Saving Audio Stream Files. You can save AC-3 audio stream files as *.AC3 files.
To save all or part of an audio stream file, use the following procedure:

1. Open an AC-3 audio stream file or other file containing an AC-3 audio
stream (sedudio Stream File Typam page 1-1).

2. Make sure that the Frame view is active.

3. SelectSave adrom the File menu or click theave Asbutton on the Upper
Toolbar.

gAudio Stream Saving -» letpc.cmp

4l the audio stream

Repetition Count
& From Frame |1— Eoah 1o i

|3
" From millisecond I duration I

SAVED AUDID STREAM' 5 MAME

Ok I Cancel

4. Inthe Audio Stream Saving dialog box, specify what portion of the stream
you want to save by selecting one of the following options:

m  All the audio streanmThis option is the default for storing encoded
streams and will save the complete audio stream.

m  From frame.This option allows you to save a specific portion of the
audio stream. Enter the starting frame in the From Frame text box and
the length of the frame in the length text box.

m  From millisecondsThis option allows you to save a specific portion of
the audio stream. Indicate the starting time in the From millisecond text
box and number of the milliseconds in the duration text box.

5. Select the number of times you want to save the audio data in the Repetition
Count text box, and then cli€BK. For each repetition greater than one, the
audio stream or the selected portion will be appended to the first repetition.

MPEG Test System Dolby Digital Audio Analyzer 2-15



Operating Basics

Analyzing Audio Streams

2-16

6. You are prompted for the audio stream file name with the following dialog
box.

Save as
File name: Ealders:
- ac3 cimts2004audio
Cancel
acmod?_0ac3 = = 2] 4|
acmodi_0ac3 = MTS200
acmod3_2.ac3 = AUDID Help |
E E
Save file as tvpe: Drives:
Audio Files (*AC3) sl [=e =l Nework.. |

7. Select or type the file name and extension, and then §afect

You can analyze audio streams for errors in the following ways:

m  Syntactic AnalysisSearch for errors in the value(s) of a structure.
m  Semantic AnalysisSearch for errors in the MPEG structure.

m  CRC CheckSearch for errors in transmission or decoding.

m  Automatic AnalysisPerform a series of analyses of an entire stream.

Syntactic Analysis. Syntactic analysis detects when a field has a value disallowed
by the Dolby AC-3 standard, independently of any other field (typically a bad
frame header). Some fields can have a reserved value, which could make some
decoders crash. When no default value is defined in the standard, a reserved
value is considered a syntax error and will generate an error message.

Syntactic analysis is available when the active view contains syntactical
analyzable material (for example, the Delta Bit Allocation view). Otherwise, the
menu command is unavailable, for example, when the Main Characteristics view
is active.

The analyzer can perform syntactic analyses on a specific MPEG2 AC-3 audio
stream syntax or on the complete stream.

To analyze a specific syntax, do the following:

1. Display the interpreted view window for the syntax you want to check. For
example, in the Frame view, double-click on B! icon to analyze the Bit
Stream Information syntax.
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2. To provide a complete inventory of each incorrect field, s&gntactic
from the Analysis menu. The analyzer performs syntactic analysis on the
open window. The frame number in the Top Line of the interpreted view
cycles through the frames of the audio stream to indicate that the analysis is
being performed. If you want to stop the analysis, pE&S. Detected
syntax errors are displayed in a Message for... window.

3. To display one error at a time, selBlExt error in the Edit Toolbar display.

4. Inthe displayed Sl or BSI view, the errors are displayed in red. Double-click
on the error to display an explanation.

To analyze the entire stream, perform an automatic analysis wiBytitactic
analysis option checked (sAatomatic Analysibelow).

Semantic Analysis. Semantic analysis checks the coherence of all AC-3 parame-
ters as indicated by the standard. You can perform semantic analyses only from
the Frame view.

To perform a semantic analysis, use the following procedure:
1. Navigate to the Frame view.
2. SelectSemanticfrom the Analysis menu.

3. The analyzer performs a semantic analysis of the entire stream and reports
any errors in an error message window.

4. Double-click an error message to display the interpreted view of the element
in error.

To analyze the entire stream, perform an automatic analysis with the syntactic
analysis option checked (sAatomatic Analysibelow).

Automatic Analysis. You can use the Automatic Analysis function to perform
syntactic analysis, semantic analysis, or both. This function is only available
when the Frame view is active.

To perform an automatic analysis, use the following procedure:

1. Select which analyses to perform:
a. SelectAutomatic analysisfrom the Options menu.
b. In the resulting dialog box, select Syntactic, Semantic, or both types.
c. Click OK.

2. Be sure that the Frame view is active.

3. SelectAutomatic from the Analysis menu.
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Decoding Audio Stream

2-18

Files

4. The analyzer performs the analyses that were selected in the Options menu.
If Syntactic is selected, a syntactic analysis is performed on the complete
audio stream.

5. A message window displays the results of the analysis. If the analyzer
detects errorgrrors appears in the right column. Double-click the word
Errors to display the error message window.

& Automatic analysis for jazdy_e.cmp M=l E
Status Result
Syntactic Completed 0K
Semantic Running...

Abort after current task

CRC Error Check. CRC information is displayed in two ways:

m  Each time you open a frame, the analyzer performs a CRC analysis and
displays the result at the bottom of the Frame view. For more information
about this display, sderame Viewon page 2-9.

B The AC-3 stream contains two CRC words per frame. You will find CRC1
in the results of the first five-eights of the frame; CRC2 occurs in the results
of the last three-eights of the frame. For an interpreted view of CRC1,
double-click theSl icon to open the CRC view. For an interpreted view of
CRC2, double-click th€RC icon to open the CRC view.

For more information about this display, $&gclic Redundancy Chedh
page 3-16.

You can decode an audio stream and view the audio waveform using graphical
views. See the following pages in tReferencesection for additional informa-
tion:

m  Dialog Normalization graph See page 3-16
m  Heavy Compression graph See page 3-17
®  Dynamic Range graph See page 3-17

To generate a stream summary, use the Stream Summary command from the
Decode menu. For more information, &eam Summarnyn page 3-17.
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Printing Audio Stream  You can print any of the view windows except the Main Characteristics view. To
Data  print the information displayed in a view window, use the following procedure:

1. Specify the page layout by selectiRgnter setup from the File menu.
Make appropriate selections for paper size and source, orientation, and
margins from the Page Setup dialog box.

2. Specify the printer connections by selectingRnieter command button,
and then making the appropriate printer and printer properties selections (see
your Windows documentation).

3. Return to the view window you want to print and seRatt from the File
menu.

4. In the Print dialog box, make selections and print the contents of the active
view window.

NOTE. You may need to change the font and page margins to print all the
information displayed in some of the interpreted view windows.

Loading a Configuration  You can load a previously saved configuration file (.acf file) into the current
File  analyzer session by selecting fRead configuration command from the
Options menu. This operation will affect the base, font, and interpretation
parameters.
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This section provides detailed information on the Dolby Digital Audio Analyzer.
and is organized into the following subsections:

®m  Binary and Hexadecimal ViewBescribes how you can use these views to
display and interpret audio stream data.

m [nterpreted View Display®escribes how to interpret tabular and linear
display formats.

®m Interpreted Frame View®escribes how to open an interpreted view of any
element in the Frame view.

m  Graphical ViewsDescribes how to generate normalization, compression,
and dynamic range graphs.

m  Error MessagesDescribes how to interpret the syntactic and semantic
analyses error reports.

m  Configure Analyzer Paramete®escribes the Options menu selections.

Binary and Hexadecimal Views

The Binary and Hexadecimal windows display the audio bitstream for the MPEG
element indicated in the top line of the interpreted view window.

Use one of the following techniques to display a Binary or Hexadecimal view:

®  From an interpreted view, click tiedd view Toolbar button, and then select
eitherBinary or Hexadecimd from the submenu.

®  From an interpreted view, sele®td view from the Window menu, and then
select eitheBinary or Hexadecimalfrom the submenu.

The Edit Toolbar is available for both views, so you can step through the binary
or hexadecimal information for other frames. When you salekt error, the
analyzer looks for syntactic errors and not semantic errors.
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Interpreted View Displays

These displays allow you to interpret the values of the various AC-3 elements.
Two types of displays are available: tabular and linear. Both displays are
interactive, allowing you to determine which signal you are viewing when you
examine the syntax.

Tabular Display. Tabular displays are interpreted views that present the extracted
information in tabular format, such as the following view.

@Exponenls for the Full Bandwidth Channel(z] M=] E3
[ Exponents for the Full Bard Width Chantels | Blook 0 - Frazs 2 - Position : 1792 - Tirs : 320000005
| Exponents for the Center channel |
Eaqoz k] [0 umits] Gainmg
x10 0 1 2 3 4 5 i} 7 3 9
Hl 122 ) 34 15 5 0 2 og oa 124
=]
+10 33 58 58 62 1 a7 62 32 63 41
+20 62 62 13 g i3] a7 41 26 i3] 4
+30 41 a7 42 41 62 43 57 82 &7 37
+40 62 82 ) 3 42 3% 42 57 102 63
+50 37 62 63 57 B4 16 102 62 62 62
+Hil 82 62 46 82 82 26 e [ 34 20
+10 a7 37
-
4] | H

In addition to the information common to all interpreted views, tabular views
have the following unique features:

m [nformation is presented in table format.

®  Row and column headings provide access to descriptions of the displayed
syntax.

m  Data displayed in the cells is one of two types: actual values for AC-3
parameters or indices for a set of values from the standard.

m  Red values indicate syntax errors.

You can double-click a row or column heading to display a description of the
contents. You can also double-click a cell to interpret its data. To display data in
decimal or hexadecimal format, press H2sfunction key.

When you double-click a cell or heading, a message box appears. The Title Bar
of the message box indicates the specific syntax displayed. You can position the
box anywhere within the view window by clicking and dragging the Title Bar of
the box. Click anywhere outside of the box to dismiss it.
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Linear Display. Linear displays are interpreted views that present the extracted
information in a series of rectangles, such as the following view.

@Exponents for the LFE Channel M=] 3

-
| Exponents for the LFE channel | Block 0 - Frarme 2154 12184 - Position : 3911936 % - Tiree : 69256.000000 = ﬂ

LfeExps[0]| | LfeEaxps | | LieExps

L+ [ = J[us ]

al | a0

In addition to the information common to all interpreted views, linear views have
the following features:

m | arge rectangles display parameter names. You can double-click a large
rectangle to display a message box containing the parameter description. You
can move this message box anywhere within the view window by clicking
and dragging the Title Bar of the box. Click anywhere outside the box to
dismiss it.

m  Shaded large rectangles denote important AC-3 parameters.

®  Small rectangles display the parameter value. You can double-click a small
rectangle to display a message box containing an interpretation of the
displayed value. Click anywhere outside the displayed message box to
dismiss it.

m  Values displayed in red indicate syntax errors.

You can display parameter values in decimal or hexadecimal format. To switch
between the two, press th& function key. Alternatively, sele@asefrom the
Options menu, and then make the selection from the dialog box that is displayed.

Linear displays can indicate the position or length of a parameter in the
bitstream. When enabled, this information appears below the small rectangles.
You can determine which type of information to display, if any, using the
following procedure:

1. Selectinterpretation from the Options menu.
2. SelectPosition or Length, or deselect both options.

m  Positionindicates the position in the bitstream of the first bit of the
parameter. Position is relative to the first bit in the displayed element.

m  Lengthis the length in bits of the parameter.
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Each time you start a new session, the analyzer uses the Interpretation option
selected from the previous session. The default Interpretation option displays
neither length nor position information.

Using the Toolbar to Navigate .You can use the Edit toolbar to navigate through
the elements of an audio stream file. (§elé Toolbaron page 2-2.) In the
Frame interpreted view, tip® button takes you to the displayed element in the
next frame. In an Audio Block view, tipe button takes you to the next item or
block.

In the interpreted view, the analyzer looks for syntactic errors (not semantic
errors) when you click thext error button in the Edit toolbar. (The Edit

toolbar is inactive in the Frame view.) If you selleixt error while the CRC
interpreted view is displayed, the analyzer displays the next detected CRC error.

Interpreted Frame Views

To open an interpreted view of any element in the Frame view, double-click the
icon of interest. Double-click any resulting cell to read an interpretation of the
data for that cell.

B Frame view -> ecl.ac3 [ (O] ]
2
Frarae | - Position : 0 - Tirne : 0000000 ms

(51 5 7 o 7 o 7 A g 0
Audin

mchronizatic  Bit Stream bowdhary  Error Check
Inforrnat  Information Blocks data

Tirme duration : : 32.000 ms

Frame Size ;0 1792 biytes

The CBC for the current frame is valid
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Synchronization ~ Double-click theSI icon from the Frame view to display a graphical representa-
Information (SI) View tion of the Synchronization Information. This view uses a linear display.

mﬁynchmnizatiun Information view [S1] -» ec3.ac3

Synchronization Information | Frame | - Position : 0h - Tire : 0.000000 s ﬂ

Symeoword CERCL FrmiSizeCod

][ e | R

This Code indicates the sampling
rate.

-

M

Binary Stream Information ~ Double-click theBSI icon from the Frame view to display a graphical represen-
(BSI) View tation of the Binary Stream Information. This view uses a linear display.

Frame 1 - Position : 0'b - Tiree : 0.000000 ¢ i
BSId BSMod ACKMod
e Lo [ 7
Chlinlev Surlulinlew LifeOn
o J[ o J[ o |
DialMorm CormptE Compr LangCodE LangCod AndProdlE Tlix evvel
L QL v e JL v J[ ¢ J[ 1
CopyrightB OrigB5 TimeCodlE TiraeCodiE AddBsE
L+ Jf v JL o J[ s [ o .
JC [

The BSI view displays several fields of information, depending on the mode.
Optional field indicators (like ComprE, AudProdIE) appear in white on the

screen. Data found in the additional field cannot be displayed, you must click the
data area to open a raw view window.

Double-clicking the large rectangle identifies the field data. (The format
displayed depends on the frame from which you accessed the Auxiliary Data
interpreted view.) Double-clicking the small rectangle displays the message Bit
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Audio Block Views

3-6

value. In order To use the Next error button on the Edit toolbar, display the
bitstream first by double-clicking on the large rectangle.

Double-click an Audio Block icon (ABO — AB5) from the Frame view to display
the Audio Block view.

B8 Frame view -> ecl.ac3

Frarne 1 - Position : 0 - Tites : 0000000 rus

ruchrondzatic  Bit Stream Suxiliary  Error Check
Informat  Information Blocks data

Double-click an Audio Block view icon to display an interpreted view window
of detailed information for the current frame. Double-click any resulting cell to
read an interpretation of the data for that cell.

uAudio Block view -> ecl.acd

| | %

Ludio Block wiew (AB) Block 0 - Itern 1- Frame 1 - Pogition : 0% - Tiree : 0.000000 ¢

Block Dither flags Dwymaric tange  Coupling Exponent  Exponents  Bit allocation Durny data OQuantized
switching Strategy Info Strategy Tilantissa

Corarmon

Coupling

FBW

WA 2 ] i

The following section discusses the individual Audio Block interpreted views.
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Block Switching View. This view displays a block switching flag for each full
bandwidth channel (a maximum of five channels). These flags indicate whether
the current audio block was split into two subblocks during transformation from
the time domain into the frequency domain.

The following AC-3 data is displayed:
m  BlockSw(for each full bandwidth channel)

Block O - Ttern 1- Fravee 1 - Position : 0% - Tixee : 0000000 5 il
CH Left Center Right Smrleft SurRight
BlkSwr(ch] 1 1 1 1 1
-
4 | H 4

Dither Flags View. This view displays a dither flag for each full bandwidth
channel (a maximum of five channels).

The following AC-3 data is displayed:
m  DithFlg (for each full bandwidth channel)

Dither Flags =
DithFlag[ch] Block O - Ttera 1- Frame 1 - Position : 0 - Tirme : 0.000000 5 i’
CH Left Center Right Smrleft SurRight
DithFlaz[ch] i i ] i i
1] | B

Dynamic Range Control View. This view displays the current frame fields; data is
common to all channels. These fields may also be traced in the Dynamic Range
graph (see page 3-17), in which case the unit is a block instead of a frame.

The following AC-3 data is displayed:
m  DynRngE
®  DynRng
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®  DynRngE
® DynRng2
L‘_Dynamic FRange Control M=l E3
Diymamic range Block 0 - Tter 1- Frame 1 - Position : 0b - Time : 0.000000 s =
DymEngE
1] | H 4

Coupling Strategy Info View. This view displays coupling strategy and channel
data for each full bandwidth channel.

The following AC-3 data is displayed:

m  CplStrE

m  CplinU

m  ChInCpl(for each channel)

m  ChsFlginu

m  CplBegF

m  CplEndF

m  CplBndStrc(for each coupling frequency subband)

Fif] Coupling Stiategy [_ O] =]
Coupling strategy | Block 2 - Ttem 3- Frame 1 - Fosition : 0 - Time - 0.000000 & f’
CpISUE | | Cpllnll © Left Center Right Surleft SwRight | |CplBegF | [CREndF
ChixCpl[cH] 1 1 1 1 1
1 1 10 12
sbnd  Subband Subband Stblband Subbard Suband Subbard Subhand Subband Subhand Subband
0 1 2 3 4 5 [ 7 H 9
CplBndStre
5
< | H 4

Coupling Data View. This view displays coupling channel data for each full
bandwidth channel. In the upper array of this view, the length of the fields or the
relative position to the beginning of the syntactic portion is given in the field
interpretation (not shown).
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The following AC-3 data is displayed:
m  CplCoEandMstrCplCo(for each channel)

m  CplCoE[ch][bnd] (coupling coordinates exponent). Represented in a
two-dimension array, up to 18 bands are displayed; unused bands are crossed
out.

m  CplCoMant[ch][bnd] (coupling coordinates mantissa). Represented in a
two-dimension array, up to 18 bands are displayed; unused bands are crossed
out.

m  PhsFlg(for each coupling band up to 18)

[T3 Coupling Data =] E3
Coupling Coordinates | Block 2 - Frare 1 - Position - 0'b - Time  0.000000 s =

[ Coupling Dita for the Left channel |

Cplcek | [MetCpica brd  bad band
[Lef] [Left]
CplCoRxp 2 2
[ I o ]
CplCoMent 0 0
[ Cloupling Diata for the Center charmel |
CpltoE || MstCpico bod  band band
[Cente] || [Center] 0 1
CpltoEsp 2 2
L [ o
CplCobant i i

| Coupling Data for the Right channel ‘

CplCoE MstrCplCo | band Tand
Fighd] || [Right 9
CplCoEm 2 2
1 a
CplColant [ [
LN [ vl

Rematrixing View. This view displays data about full bandwidth channels only.
The following AC-3 data is displayed:

m  RematStrif Rematris on, the array of rematrixing flags is displayed

(RematFlg[ch).
Rematnxing =] E3
Blnck 1 - Frates 500 /2124 - Position : 894202 b - Tiwe - 15968 000000 5 ﬂ
RematStr fond) Band Band Band Band
RematFlglch] 0 0 n n
1] | A7
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Exponent Strategy View. This view displays the following AC-3 data:
m  CplExpStraf(reuse, D15, D25, D45)

m  chexpstrfor each channel)

m | feExpStr

m  ChBwCod[ch](channel bandwidth code)

Exponent Strategy M=l
Block 0 - Iter 55- Frae 10 - Position : 16128 - Tirce - 288000000 s 4
plExpStral Ch| Left Center Fight Swleft SurBlight
chexpstrch] 1 1 1 1 1
Ch Laft Center Right Swleft SurBight
ChBwCod[ch]
-
4] | AV

Exponents View. There are three exponents views; one for each channel type
listed along the left side of the Audio Block view window. Icons for one or more
of these channels appears in the Audio Block view.

Exponents for the Coupling Chann€&his view displays the following AC-3
data:

m  CplAbsExp(coupling absolute exponent)

m  CplExps(for each group of three exponent values for the coupling channel)

@Exponenls for the Coupling Channel [_ (O] x
| Exponents for the Coupling channel | Block 0 - Frame 10 - Position : 16128 b - Time : 282.000000 s —
EplibsExg nrits
x10 0 1
+0 37 62 6l 27 62 62 62 &6 63 a7

< | »
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Exponents for the Full Bandwidth Channel(Bhis view displays the following
AC-3 data:

m  Exps[ch][0] (absolute exponent values)
m  Exps[ch][grp] (values of each group for the other channels: 85 columns)

m  Gainrng[ch] (channel gain range code)

EExponenls for the Full Bandwidth Channel(z] =] E3
| Esponents for the Full Bard Width Chantels | Blook 0 - Frams 2 - Position : 1792b - Tire : 320000005
| Exponents for the Center channel |
Eagos k] 1] umits| Gainmg
x10 1] 1 2 3 4 5 ] 7 2 9
Hl 122 ) 54 15 5 0 2 o9 el 124
]
+0 33 58 58 62 al 7 62 32 63 41

+20 ¥ 62 i 8 ] a7 4 26 ] w

+i0 61 &7 42 4 ] [x] 5 52 a7 37

+50 37 62 63 57 34 16 102 [ ] ]

+Hill a2 2 46 32 B2 Fiti] T8 [ 34 20

+70 a7 kn

4] | AV

Exponents for the LFE channdlhis view displays the following AC-3 data:
m | feExps[0](absolute initial exponent)

m |feExps[gr](values of each group for the LFE chang®l

@Exponenls for the LFE Channel !EB

| Exponents for the LFE channel | Block 0 - Frarme 2154 1 2154 - Position : 3911936 % - Tirae : 69856.000000 s ﬂ

LfeExps[0]| | LfeExps | | LieExps

L+ [ = J[us ]

1 | 2y

MPEG Test System Dolby Digital Audio Analyzer 3-11



Reference

3-12

B
[
[

Bit Allocation =

it Allocation View. This view displays the following AC-3 data:
baie SDcyCod, FDcyCod, SGainCobPBCo,FloorCod, SnrOffstE
CSnrOffst
FSnrOffst
CplFSnrOffst, CplFGainCod
FSnrOffstandFGaincod(for each channel)
LfeFSnrOffst, LfeFGainCod
CplLeakE, CplFleak, CplSLeak

DeltBAIE (Delta Bit Allocation Information )

Block O - Ttern 55- Frame 10 - Position : 161228 b - Time : 222.000000 s

baie | |SDeyCod| [FDeyCod| 3GanCod | [DhPECod| (FloorCod | [SnrOffstE

Loz J e e Jis Lo JL 1 |

CErOffet chl Coupling Left Center Right SurLeft SurRight
FanrOffst 15 15 15 15 15 15
FlrainZod 4 4 4 4 4 4

pILeakE| [CpIFLeak] [CplSLeak| [DeltBAIE
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Delta Bit Allocation View. There are three types of Delta Bit Allocation views.
Depending on the audio stream file, one or more of these icons may appear in the
Audio Block view.

Common Delta Bit AllocatianThis view displays the following AC-3 data:
m  CplDeltBAE
m  DeltBAE[ch]

Common Delta Bit Allocation

- [O] x|

| Ezdstence of Delta bit allocation information | Block 2 - Frame 1 - Position : Ohb - Tirae - 0.000000 5 ﬂ

plDeltB & H

CH

Left

Center

Right

Surl eft

SurRight

DeltBAE

2

2

2

2

2

4

AP

Delta Bit Allocation for the Coupling Channdlhis view displays the following
AC-3 data:

m  CplDeltNSeg

m  CplDeltOffst[seg
m  CplDeltLen[seq]
m  CplDeltBA[seq]

Delta Bit Allocation for the Coupling Channel

DeltlSeg Block 0 - Frame 725 - Position : 1404928 b - Time : 25082 000000 s ﬂ

M[=] E3

plDeltt Se Seg] Seg Seg Seg Seg
CplDeltOffst 14 17 17 28
CplDeltlen 11 & 7 o
CplDeHBA 4 2 & o
Jd | 1y
3-13
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Delta Bit Allocation Information for FBW Channel(3his view displays the
following AC-3 data for each full bandwidth channel:

m  DeltNSeg[ch]

m  DeltOffst[ch][seq]
m  DeltLen[ch][seq]
m  DeltBA[ch][seg]

Delta Bit Allocation for the FBW Channel(s) =] E3
| Delta offset, delta length and delta bit allocation | Block 1 - Fram 470 - Position : 340448 b - Tine : 150020000005 ~—
[ DeltaBit Allocation for the Lot charmel |
DelthSeg Segl Seg Seg Seg
DeltOffst 24 4] 2
DeltLen [ 0 2
DeltBa ] 4 2
Delta Bit Allocation for the Center charmel
DelthSeg Segl Seg Seg Seg Seg Seg
DeltCffet il 12 5 2% 2
DeltLen 13 15 o 12 g
DeltBA [ 7 il 0 1
e P

Dummy Data View. Dummy data is common to all channels. This view displays
the following AC-3 data:

= SkipLE
m SkipL
= SkipFld
Block 0 - Itetn 55- Fraze 10 - Position : 16128 b - Time : 282000000 s i’
SkipLE
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Quantized Mantissas View. The mantissa view is considered a common view
because the channel order is standard: full bandwidth coupled channels, followed
by the coupling channel and full bandwidth noncoupled channels, and finally, the
LFE channel. There is a matrix for each channel type and a separate LFE
mantissa view. Order of appearance in the stream is respected:

This view displays the following AC-3 data:

m  ChMant[ch][bin] (full bandwidth coupled channels)

m  CplMant[bin] (coupling channel)

m  ChMant[ch][bin] (full bandwidth noncoupled channels)
m | feMant[bin]

E® Quantized Mantissas M= E3
Block 0 - Ttera 55- Frame 10 - Position - 16128 - Tire - 2220000005 —

[ Motissafor the Left chamel |

Jats|
x10 0 1 2 3 4 5 [ 7 g 9
H 15168 | 9024 2404 0611 | 25928 | 57120 | 24656 | 57664 | 23352 a
+10 a 2 a a a a a 0 0 a
+20 1) a a a o o o 1) 1) 0
+30 1) a a a o o o 1) 1) 0
40 0 a a a o o o 1) 1) 0
+50 0 1} 1} 1} o o o 1} 1} 0
+H60 a a a a a a a 0 0 a
+70 a a a a a a a 0 0 a
+30 a a a a a a a 0 0 a
+90 i} a a a 1] 1] 1] 0 0 i}
+100 1) a a a o o o 1) 1) 0 =
A oz

Auxiliary Data (AUX) View  Double-click theAUX icon in the Frame view to display a graphical representa-
tion of the auxiliary data view. This view uses a tabular display.

.Auxillary Data ¥iew -> ecl_ac3 =] E3
Lwdts Frare | - Position : 0 - Time : 0.000000 =
Lotz Bovdatae
|in|:|:|mplete bytes, see binary view !!!| | a
RN M 4
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Cyclic Redundancy Check  Double-click theCRC icon from the Frame view to display a graphical
(CRC) View  representation of the CRC error syntax. This view uses a linear display.

EA|CRC View -> ecl.ac?

CRC-Error Detection Ciode Frarae 1 - Position : 0'b - Tirae : 0.000000 s il

CROSY CRC-Emor Detection

|::: Qi dEt

=

|| 40230

-

1] | AN

The small rectangle in the CRC error interpreted view displays the CRC value.
Red values indicate errors. Display other CRC errors by selectiigttiesrror
button in the Edit toolbar.

Graphical Views

You can plot the following types of graphs with the Dolby Digital Audio
Analyzer: Dialog Normalization, Heavy Compression, Dynamic Range. The
analyzer plots the stream element field values on the vertical axis and their
corresponding frame numbers on the horizontal axis. If you need to abort during
the graphing process, press E&C key.

After the analyzer plots the graph, use the Edit Toolbar to navigate through the
blocks, items, and frames.

Dialog Normalization ~ This graph is available only from the Frame view.
Graph . o .
P To generate the Dialog Normalization graph, do the following:

1. Be sure that the Frame view is active.

2. From the Decode submenu selécaph; then selecbialog Normalization
from the submenu.

3. Enter a number to specify at which frame to start the graph.
4. Enter the number of frames to plot.

5. Click OK. The displayed graph shows the frame numbers you specified on
the horizontal (X) axis and the dialog normalization values on the vertical
(Y) axis. Interpreted values are represented in decibels.
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Heavy Compression  This graph is available only from the Frame view.
Graph . :
P To generate the Heavy Compression graph, do the following:

1. Be sure that the Frame view is active.

2. From the Decode menu sel&itaph; then selecHeavy Compressionfrom
the submenu.

3. Enter a number to specify at which frame you want the graph to start.
4. Enter the number of frames to plot.

5. Click OK. The displayed graph shows the frame numbers you specified on
the horizontal (X) axis and the heavy compression values on the vertical (Y)
axis. Interpreted values are represented in decibels.

Dynamic Range Graph  This graph is available only from the Audio Block view.
To generate the Dynamic Range graph, do the following:
1. Be sure that the Audio Block view is active.

2. From the Decode menu selé&taph; then selecDynamic Rangefrom the
submenu.

3. Enter a number to specify at which frame you want the graph to start.
4. Enter the number of frames to plot.

5. Click OK. The displayed graph shows the frame numbers you specified on
the horizontal (X) axis and the dynamic range values on the vertical (Y) axis.
Interpreted values are represented in decibels.

Stream Summary  To generate a stream summary, be sure the Frame view is active, and then select
the Stream Summarycommand from the Decode menu. The displayed
information (such as version number, sample frequency, and type) is the same for
all successive frames until new information appears.
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For example, in the following illustration the displayed information is the same
for frames 1 through 312.

EX Message for Frame view -> acmodswp.ac3 M=l B3

......atream Summary for acmodswp.ac3

Frame # 1, Ver: 8, Sample Freq: 48 kHz, Type: Complete Main, Bitrate: 448 kb/s. Coding Mode 1{0, 1 Channels, LFE off

Frame # 313, Yer: 8, Sample Freq: 48 kHz, Type: Complete Main, Bitrate: 448 kbfs, Coding Mode 2{0, 2 Channels, LFE off
Frame # 625, Yer: 8, Sample Freq: 48 kHz, Type: Complete Main, Bitrate: 448 kbfs, Coding Mode 3{0, 3 Channels, LFE off
Frame # 937, Yer: 8, Sample Freq: 48 kHz, Type: Complete Main, Bitrate: 448 kbfs, Coding Mode 2{1. 3 Channels, LFE off
Frame #1249, ¥er: 8, Sample Freq: 48 kHz, Type: Complete Main, Bitrate: 448 kbfs, Coding Mode 3/1, 4 Channels, LFE off
Frame #1561, ¥er: 8, Sample Freq: 48 kHz, Type: Complete Main, Bitrate: 448 kbfs, Coding Mode 2/2, 4 Channels, LFE off
Frame #1873, Yer: 8, Sample Freq: 48 kHz, Type: Complete Main, Bitrate: 448 kb/s, Coding Mode 342, 6 Channels, LFE on

Totol of 2184 data frames.
Total playing time is 1 minutes 9.888 seconds

4]

Error Messages

When you perform a syntactic or semantic analysis, the analyzer generates an
error report if it finds any incorrect fields.

To display error messages in the interpreted view, cliclthe error icon on
the Edit toolbar. This will advance through all the error messages, one at a time.

The error values are displayed in red. You can double-click the value to display
an explanation of the error.

Error Reports ~ Each line in the error report contains the following information:

The frame number

The block number

The level of error

The type of error (semantic or syntactic) in the case of Automatic analysis

The name of the error (such as CRC error or synchronization error)

Saving Error Messagesto  To save error messages to a file, select Error messages from the Options menu.
aLOG File  For additional information, see page 3-20.

Configure Analyzer Parameters

You can configure several analyzer parameters. You can also save the configura-
tions and load them again (or transfer them to another analyzer), and you can
reset the parameters to default conditions.

3-18
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You can specify which analyses to perform when you sg@letcimatic from the
Analysis menu. You can also set the default directories that will be used when
saving error messages to a file and when saving and loading configuration files.

NOTE. The Options menu selections apply to the analyzer and not the audio
streams displayed. Consequently, when an audio stream is opened, the informa-
tion displayed reflects the current analyzer configuration. When you begin a new
session, the analyzer loads the configuration options used during the previous
session, saved when you exited.

Saving and Loading  You can save the current analyzer settings to a configuration file that you can
Configuration Files  transfer to another system or reload at a later time.

Save. To save the configuration to a (*.acf) file, do the following:

1. Use the Options menu to select the desired Base, Font, and Interpretation
settings.

Menu item Description

Base Use this selection to determine how the interpreted views display the audio
elementary stream data. The analyzer can display data in either decimal or
hexadecimal base. You can enter values only in decimal base.

Font Use this selection to determine which font is in use in some analyzer view
windows. The Main Characteristics, Binary and Hexadecimal view windows
use a fixed font and are not affected by the font selection.

Interpretation This selection allows you to display the length or the position of a field in the
bitstream. This information is only available in linear display view windows.

Position indicates the position in the bitstream of the first bit of the field.
Position is relative to the to the first bit in the displayed structure.

Length is the length of the field in bits.

2. SelectSave configurationfrom the Options menu.

3. Select the desired path and enter a file name for the configuration file. You
can also select an existing configuration file to write over.

4. Click Save The .acf suffix will be added automatically.

Load. To load a configuration file, do the following:

1. SelectRead configurationfrom the Options menu.
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2. Select the configuration file that you want to load.

3. Click Save The analyzer settings will be reset to the saved settings.

Set Default Directories. To assign a default directory for saving and retrieving
configuration files, do the following:

1. SelectDirectories from the Options menu.

2. Under Configuration Directory, enter the path that you want to use when
saving an loading configuration files.

3. Click OK.

Setting the Default ~ To reset the configuration parameters to the defaults, Ssedefault
Configuration  configuration from the Options menu and clidesin the dialog box. The
analyzer uses the defaults listed in the table below.

Menu item Default setting

Base Decimal

Font Times New Roman, Regular style (no italics or bold), 9 point size
Interpretation No length or position display selected

Saving Error Messagesto  You can set the analyzer to automatically save error messages in a file.
a File . :
To set the Default Directory, do the following:
1. SelectDirectories from the Options menu.

2. Under Message directory, enter the path to the directory where you want the
error message file stored.

To save error messages, do the following:
1. SelectOutput message in filesfrom the Options menu.

2. Perform an analysis. If the analyzer finds errors, it creates an error message
file (*.log) in the directory you specified. Where * is the name of the AC-3
file.

To open an error message file, navigate in Windows to the specified directory
and locate the *.log file. For example, the error file created is cakext>.log.
Open the file in a word processing program, such as WordPad.
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Automatic analysis, 2—-17
SymbOIS AUX icon, 3-15
AC3 file, 1-1 Auxiliary Data view, 3—15
.acf file, 3-19
log file, 3—-20
PRG file, 1-1 B
.TRP file, 1-1 Bar
VOBfile, 1-1 edit tool, 2-2, 3-4
menu, 2—-2
A status, 2-2
title, 2—-2, 2-3
Absolute initial exponent, 3-11 upper tool, 2-2
AC-3 Binary Stream Information (BSI) view, 3-5
displayed signal Binary view, 2-9, 3-1
bitrate, 2-5 Bit Allocation view, 3—12
copyright, 2-5 Bitrate, of AC-3 display, 2-5
number of channels, 2-5 Block number, of audio blocks, 2—7
sampling frequency, 2-5 Block Switching view, 3—7
service type, 2-5 BSlicon, 3-5
saving files, 2-14 Buttons
AC-3 standard, version of, 2-5 edit toolbar, 2-2
Add view, 2-6, 2-9, 3-1 upper toolbar, 2—-2

example exercise, 2-10
table of available views, 2—-10

Analysis C
automatic, 2—-17 .
CRC, 2-18 Channel gain range code, 3-11
Close
menu, 2-12

all windows, 1-3
view window, 1-3
Code, channel gain range, 3-11
Common Delta Bit Allocation Information view, 3—-13

of audio stream files, 2—-16
semantic, 2-17
syntactic, 2—16

Ant;/|pieorf’ i Common information, in audio block view, 2—7
. Configuration
configure parameters, 3—18 file
i load, 3-19
start up, 1-2 o 310
Apg('i?ai'fg load previous file, 2-19
star,t up, 1-2 preserve, 1-3
windov[\)/’ 2-1 set default, 3—-20
Audio block Configure analyzer parameters, 3-18
icon, 2—-7, 2-8, 3-6 Contacting Tektronix, iv

interpreted view, 28 Copyright, of AC-3 displayed signal, 2-5

i Coupling
view, 2—7, 3—-6
Audio stream absolute exponent, 3-10

extract file from transport stream, 2—-14 band flag, 3-9
file analysis, 216 coord!nates exponent, 3-9
file decode ’2—18 coordinates mantissa, 3-9

viewing, 2-4 Coupling Channel
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delta bit allocation view, 3—13 menu, 2-11

exponent view, 3—10 open, 1-3

in audio block view, 2—7 open error message, 3—20
Coupling Data view, 3-8 save, 2-14
Coupling Strategy view, 3-8 First-time operation, iii
CRC Flag

check, 2-18 coupling band, 3-9

icon, 3-16 rematrixing, 3—9

status message, 2-9 Format

view, 3—-16 of file, 1-1
Cyclic Redundancy Check (CRC), 2-18, 3-16 table, 3-2

Frame number indicator, 2—4
Frame View, 2-6, 3-4
D Frame view, CRC status message, 2-9
Full Bandwidth Channels
exponents view, 3-11
in audio block view, 2—7

Decode, audio stream file, 2-18

Decoding menu, 2-12

Delta bit allocation information, 3—12
for FBW channels view, 3-14

for the coupling channel view, 3-13 G
Delta Bit Allocation view, 3—-13
Dialog normalization, graph, 2-9, 3-16 Graph
Directory, set default, 3—-20 dialog normalization, 2—-9, 3-16
Dither Flags view, 3-7 dynamic range, 2-9, 3-17
Dummy Data view, 3—14 heavy compression, 2-9, 3-17
Dynamic Range Control view, 3—7 Graphical Channel Indicator, 2-5
Dynamic Range graph, 2-9, 3-17 Graphical view, 2-9, 3-16
E H
Edit Hardware, installation, iii
menu, 2-11 Heavy Compression graph, 2-9, 3-17
toolbar, 2-2, 3—4 Help menu, 2-14
Error Hexadecimal view, 2—-9, 3-1

message, 3—-18
save to file, 3-18, 3-20

report, 3—-18 |
Exit, application, 1-3
Exponent Icon .
absolute initial, 3-11 audio block, 2-7, 2-8, 3-6
. AUX, 3-15
coupling absolute, 3-10 BS| 3-5
coupling coordinates, 3—9 CRé 316
Exponent Strategy view, 3—-10 edit t;)olbar > o
Exponents for the Specified Channel view, 3-10 S| 3-5 '
Extract elementary stream, 2-14 u ’ er toolbar. 2—2
using Deferred-Time Analyzer, 2—-14 PP '
Indicator
frame number, 2-4
F graphical channel, 2-5
Install
File hardware, iii
Jog, 3-20 password, 1-2
format, 1-1 software, 1-2
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Interpretation command, (Option menu), 3—-3
Interpreted view, 2—6, 3—-2
of audio block, 2—-8

L

LFE Exponents view, 3—-11
Linear display, 3-3
length, 3-3
position, 3-3
Load configuration file, 2-19, 3-19
Low Frequency Enhancement Channel information, in
audio block view, 2—7
Lower toolbar, 2—2

M

Main Characteristics view, 2—4
graphical channel indicator, 2-5
Mantissa, coupling coordinates, 3—9
Menu
analysis, 2—-12
bar, 2-2
decoding, 2-12
edit, 2-11
file, 2-11
help, 2-14
options, 2-12
view, 2—-12
window, 2—-13
Menus, 2-11
open with keyboard, 2-11
open with mouse, 2-11
open with upper toolbar, 2-11
table of, 2-11-2-14
Message, error, 3-18
opening .log files, 3-20
saving .log files, 3-20
MPEG, standards, iii

N

Next error, 3—-1
Number of channels, of AC-3 displayed signal, 2-5

O

Open
Jog file, 3—-20
application, 1-2
error message file, 3—20
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file, 1-3
Operating overview, 2—1
Options menu, 2-12
Overview, of operating basics, 2—1

P

Password, 1-2
Position indicator, 2—4
Print
command, 2-19
stream data, 2-19
Printer setup, 2-19
Product description, 1-1
Product support, telephone numbers, iv
Program Group window, 1-2

Q

Quantized Mantissas view, 3—15
Quit, application, 1-3

R

Rematrixing
flag, 3-9
view, 3-9
Report, errors, 3—-18

S

Sampling frequency, of AC-3 display, 2-5
Save
audio stream files, 2—14
configuration, 1-3, 3-19
base, 3-19
font, 3-19
interpretation, 3—-19
error message to file, 3-18, 3—20
Semantic analysis, 2-17
Service information, iv
Set
default configuration, 3-20
default directory, 3—20
Set up, hardware, iii
Slicon, 3-5
Software
bugs, iii
features, iii
installation, 1-2
version, iv
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Windows NT, iii
Specifications, iii
Standards, MPEG, iii
Start, analyzer, 1-2
Status bar, 2-2
Stream, viewing, 2—4
Stream summary, 3-17
Synchronization Information (SI) view, 3-5
Syntactic analysis, 2—16

T

Table, format, 3—-2
Tabular displays, 3-2
Time indicator, 2—4
Title bar, 2-2, 2-3
Toolbar
edit, 2-2, 3-4
upper, 2-2
Top line, of View window, 2—4
Type of service, of AC-3 display, 2-5

U

Upper toolbar, 2-2

V

Version
of AC-3 standard, 2-5
software, iv
View
add, 2-9
audio block, 2—-7, 3—6
common information, 2—7
coupling channel information, 2—7

full bandwidth channel information, 2—7
low frequency enhancement channel information,

2-7
auxiliary data, 3-15
binary, 2-9, 3-1
binary stream information, 3-5
bit allocation, 3-12
block switching, 3—7
coupling data, 3-8

Index-4

coupling strategy, 3-8
CRC, 3-16
delta bit allocation, 3—-13
dither flags, 3—7
dummy data, 3—-14
dynamic range control, 3-7
exponent strategy, 3—10
exponents for the specified channel, 3—-10
frame, 2—-6, 3—4
graphical, 2-9, 3-16
hexadecimal, 2-9, 3-1
interpreted, 3—-2
main characteristics, 2—4
menu, 2-12
guantized mantissas, 3-15
rematrixing, 3—9
synchronization information, 3-5
window, using, 2—-3, 3-2
View window
common elements, 2—3
print, 2-19
top line, 2—4
Viewing audio files, overview, 2—4
Views

common delta bit allocation information, 3—13

coupling channel exponent, 3—10

delta bit allocation information for FBW channels,

3-14

delta bit allocation information for the coupling

channel, 3-13
full bandwidth channels exponents, 3-11
LFE exponents, 3-11

W

Window
application, 2-1
audio block view, 2—-7, 3-6
frame view, 2-6, 3-4
graphical view, 3-16
main characteristics view, 2—4
menu, 2-13
print, 2-19
program group, 1-2
view, 2—-3

Windows, operating system, iii
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